Lampiran

LANGKAH-LANGKAH SIMULAS

Dalam penyelesaian skripsi ini digunakan simulat&3D dari Zeland
Incorporation untuk merancang antena dan mensimulasikan parapetmeter dari
antena hasil rancangan. Lebih jauh lagi IE3D dapgakukan optimasi, visualisasi arus
dan perhitungan pola radiasi disamping simulasilambaperancangan ada beberapa

langkah yang harus dilakukan.

Tahap 1 Pemodelan Elemen Peradiasi
Bentuk elemen peradiasi yang akan disimulasikamabadseperti ditunjukkan

pada Gambar 1. Untuk membuat geometri antena leteggunakamMGrid. Parameter
dasar dari antena mikrostrip adalah sebagai berikut

Bahan Epoxy fiberglass — FR 4

Konstanta dielektrike() =4.6

Ketebalan lapisan dielektrik) = 1.6 mm

Loss tangent =0.018

Bahan pelapis substrat (konduktor) tembaga

Ketebalan bahan konduktor (t). = 0.0001 m

Konduktifitas tembagaoi =5.80 x,10 mho m*

Frekuensi kerja (f = 2400 MHz

Impedansi karakteristik saluran =80

Gambar 1. Elemen peradiasi
Step1l BukaZeland Program Manager 12.0. Jalankan IE3D-> MGrid. Pilih
File>New commandMGrid akan menunjukkarBasic Parameter Pada
bagianlength group pilih unit sebagai “mm”. Padaeshing parameter group

ubah frekuensi tertinggiFaxX menjadi 4 GHz darCell per wavelenght
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menjadi 20. Pada substrate layer secara defagédier dudayer yaitu layer
dielectrik dan layerground Pada layeground ganti nilai konduktivitasnya
menjadi 5.80 x 10mho " (sesuai bahan konduktor yang dipilih). Kemudian
tambahkan layer baru, pilihrsert new substrate masukkan Top surface,
Ztop’ 1.6 mm, Konstanta DielektrikEpsr = 4.6. danloss tangent0.018.
kemudian pilih Ok untuk memasukkannyaMGrid siap untuk membuat

geometri.

Basic Parameters 28

Comment
Retrieve Cancel
Length Layouts and Grids Enclosures Automatic Bun Time Thickness
i ¥ o
Unit mm A
Mol Grid Size=0.025 Mo Mo Side 'wWalls

Minirum 1e-006
teshing Parameters

Meshing Freq (GHz] 1 Cellz per Wavelength 20 Meshing Scheme Classical -

tutomatic Edge Cells | AEC Disabled

Meshing Alignment Meshing alignment iz enabled with parameters: Aligning polygons and diglectics calls meshing, Max Layer Distance = 00005, Reqular Size = 14 9896, Refined
Size = 299792, Refined Ratio = 0.2

Substrate Layers )
Conductor &ssumption Limit,.  1e+006 Max DE: 500 Display Margin; 0.2 Default Tranzparency 1] a4

Mo.1: D Ztop=1e+015 T=1e+015 Epsr=1 TanD(E)=0 Mur=1 TanD(k)=0 Sigma=(0.0) Ei=0  Fd=0 Cmt=
Mo. 00 G Ztap=0 Epzr=1 TanD[E]=0 Mur=1  TanD[k]=0 Sigrma=[4 9e+007_ 0] Ei=0  Fd=0 Crmt=

Metallic Strip Tupes =
Select/DeSelect All Batch Change Property Dl A I 4

Rxkx Noolo Tk=D002 Epsr=l TanD[EJE0  Mur=1 TanD(MJ=0  Sigma=(43e+007,0)  Zs=0.0102041 Fo=0 Crat=

Dielectric Types .
Corwert from Infinite Substrate Default Transparency 0.5 aHb

Template File
Open Save

Gambar 2. Basic parameter

Catatan : pendefinisian parameter ditentukan beadlkan spesifikasi substrat dan
konduktor yang dipilih.

Step 2 Untuk membuat geometri pilikentity->Circle. MGrid akan memberikan
parameter (X,Y,Z) = (0, 0, 0). Masukkan Style paiagle poligon dan
Number of segments for cirgda maksimum (200). Kemudian untuk radius
dari dimensi circlenya pada besar yang telah ditemt pada perancangan,

yaitu 17,08 mm. PilitDk untuk meneruskannya.
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Step 3 Buatrectangularuntuk membentuk ruangset feed Caranya adalah dengan

geometri pilih Entity>Rectangular MGrid akan memberikan parameter
(X,Y,Z2) = (0, 0, 0). Kemudian masukkan panjang seb&, (11,38mm) dan
lebar sebesaWy (3,811mm). PilihOk Hasilnya seperti Gambar 3 di bawah

nl.

& Untitled - MGrid i el e
Eile Edit Param Input AdvEdit Entity Poert Optim Wiew Process Help
DEedE 2 =®w J R E T 2 =3
o # LE&aa s «> ¥ ¢t =~ s ad" N Qa
% 25475 -
¥ 19875
z18 L
da: 25,475 Y
dy: 19675 -
dz 16
dRho: 231085344 T
phi; 37.96052283
dr3230443
theta: 3716508801
O & z =
¥ z W g
1 1 B¥ooooooo «
O & [0 Pobaon
@
&
=
o]
o
a
@
v List il Lepers ©
Elevi “m
=

‘= Message | Geomety | Metalic Types | Substiates | Task List

Drawing Mode MM 295787% R2_COPYPEN No Plane Wave Defined

Gambar 3. Pembuatan ruangset feed
Step 4 Tekan ‘Shift + M” untuk memindahkan rectangular tersebut dan
diletakkan bertumpuk pada ujung lingkaran terselibat Gambar 4.

%2 Untitled - MGrid =l es
Eile gdit Param Input advedit Entity Port optim  wiew Pre
DEHE 2 =Wwm BOIRES ¢ $BRXTH L%
PWmE w0 [ AUEaQ @1 «> ¢ ¢+ 9 5
Select Palygon -
Mode
Select (Adv) Edit,

Moy or Mesh menu
to edt the geomelry

Select ExtEdtin
O & z
v 2 [l 500000
O 1 E¥ooo0000
0 A 0 Polygon

v Listal Layers

Elevated Laper

Insert aLayer
Snapped to closest verte
Snapped to closest vertt
“E Message | Geometry | Metalic Types | Subshiates | Task List
Select Polygon Mode i) 2.99797%  R2_SOPYPEN Mo Plang Wave Defined
check connection Alt+shift+o
cut overlapped Polygons... Alt+shift+0

Gambar 4. Pembuatan ruargset feed
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Kemudian pada rectangular klik kama@ut Overlapped PolygorPilih “all
overlapped polygan” dan centang pada isiarRémoved reduadant lalu

klik Ok. Kemudiandeleterectangular tersebut, seperti tampak pada Gambar 5

£ Untitled - MGrid = | ke

Eile Edit Param Input advEdit Entity Port Optim Wiew Process Help

hedE 2 ="wm 7 K @

S B2 # H  AReaQsn >+t = e 3® N oa
* 17.625
»:AT.975
=16
i 17.625
dy: 17,975
dz 16

dRho: 2517421736
phi: -45.56328306
dr: 2522601239
theta: BF 36333867

# z
2 [l o000
1 o ooooon
4 [0 Polygon

oo} O

v List Al Laers

Elevated Lapsr

He eoa D0 6w o 88 206 J &</

Insert a Layer

x
Shapped to closest vertex
Snapped to closest vetex

B
£
5
‘E Message Geometry | Metalic Types | Substiates  Task List

Far Help, press F1 mm  2.33797% R2_COPYPEN No Plane Wave Defined

Gambar 5. Pembuatan ruangset feed
Step 5 Padastep4 kita akan membuat saluran transnmsiet feed Caranya dengan
menyeleksivertices lalu pilih menuAdv. Edit > Continue straight path
Kemudian isikan panjang 14,45 mmdan lebarnya 2/@8bi. Lalu klik Ok
Lihat Gambar 6.

& Untitled - MGrid

Menggunakan tool
“select vertices”

DEEHE 2 =®w
o B =

Select [Adv] Eil,

Tempat seleksi verteks

Select Exit Editin -

O & =

“ 2 [l 500000
11 Boooooo
1 & 0 Pobigon

&

Continue Path on Edge

*+ st Direction Azimuth = -0.000000
Pathlength 1445 Intend to build multiple vertex path
Path Start Width 2811 Path EndWwidth 2811

Gambar 6. Kotak dialogContinue Straight Path
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Step 6 Pilih Port — Port for Edge Group Pilih Advanced Extention for the De-
Embedding schemelTandai Auto Adjusment Kemudian pilih Ok untuk
menerima nilaidefault Tekan shift dan pilih ertices5 dan 6 (Gambar 3.c)
untuk menentukamort. Pilih Port>Exit Port untuk keluar darport mode

Simpan dan struktur siap disimulasikan.

Step 7 Untuk melihatmeshdari antena pilih proses> meshing Kita bisa memilih
skema klasik atau-kontemporer. Pil@k untuk melanjutkan. Keluaran

ditunjukkan Gambar 7.

%25.2.ge0 - MGrid

File Edit Param Input AdvEdit Entity Port Optim  Wiew Process Help
DeEE 2 =Wwm J IR OELH ?2 B
W R g4 = LRl& & 5 <= ¥ ¢ N |

w 37125 -
y: 187175
z 16 LA
dx: 37.125 3
dy: 19.175
dz: 16
dRho: 41.7845216E
phi: 2731627738
dr: 41.81514379
theta: 87.80711306

{._I

0

O & Z -
O 4 Mo P
1 b

v Lizt All Layers

Elevated Layer -

Time @ 28 5

Inzert & Layer

X

Geometm file "E:\AkademikhSkripsi ubonbzalim skripsi fishsimulasi fixheinggle’s. 2 geo" loaded
Mezhing perfarmed successfully on the current geametm.

Information

Message Geometry  Metalic Types | Substrates | Task List

Drawing mode mm 15E006% R2 COPYPEM Mo PlaneWwave Defined

Gambar 7. Meshingstruktur

Step 8 Pilih process>simulate Kemudian akan muncul kotak dialagmulation
setup Masukkan frekuensstart freq = 2.3.GHz,End freq= 2.7 GHz dan
number of freg= 41. Kemudian pilih OK untuk melakukan simule&&imulasi
membutuhkan waktu beberapa menit, setelah simsgklssai akan muncul

MODUA yang akan menampilkan hasil simulasi (Gambar 6)
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.ub

—— aB[S(1,1)]

repository

25
Frequency (GHz}

245

Chamfered Bend

les |
Arrn Length fram Corner ||:|_1 0k |

A fidth |2_a11

Cancel

Bend Angle [deq) |E":|
Charmfer Size |':'-5
Corner |':I
Corner ' ||:I
Cormer £ |1 H
Rotation Angle [deg] ||:|
After Buit | Location Fived v

Gambar 8. Kotak dialogchamfered bend
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Step 3

5.2 Merid

Tekan ‘ShifttTab” dan sesuaikan posigrtexyang akan disambung. Setelah
itu pilih input>set to closest verteXekan‘shift+M” dan gerakkan
chamfered bencthenuju vertek dari polygon yang akan disambungKék.

dan PilihOk

Mot raun i Awem ety Port i iew Fvess veb
DEES 2R =uWm MURES ¢ SReXTe WLy
LLY

H  uEeq s «> it 5

Step 4

Step 5

& s.2 - MGrid

File Edt Porem input AfVEdt Ertity Pori Optim View Process Help

NEHS 2R ="Ww A 4 L & 8

Rt 2] E: 2 m URAQ & <= ¢ ¢ 9

Gambar 9. Pemasangachamfered -bend

Pilih vertek yang sejajar pada tepi lengahamfered dan pilih Adv
Edit>Continue Straight PatrKemudian akan muncul kotak dial@pntinue
Path on Edgelsikan nilai sesuai hasil perhitungan, yd#tath Length= 30.25
(sesuai dengan %) danPath Start Width= Path End Width= 2.811.

Pilih symetrical T-junctionuntuk membuat saluran transmisi pembagi.
kemudian akan. keluar kotak dialagymetrical T-junction (gambar 10).

Masukan panjang dan lebar saluran transmisi yarttk&kedan horisontal.
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)
Symmetrical T-lunction &=

Yertical Amn's Length 0.1

Wertical Arm's Wwidth 281

C I
Harizontal &rms' Length 01 anee
Horizontal Armm's Width 2811 Wertical Ao Direction
Charmfer Size a # Direction
Center a - Direction
* Y Direction
Center 0 -t Direction
Center £ 1.6
After Built Location Fised =

Gambar 3 Kotak dialogsymetrical* T-junction

Pilih Edit->Rotate untuk merotassymetrical T-junctionyang sudah dibuat
agar sesuai dengan model rancangan. Masukkari i

& 5.2 - MGrid

File Edt Param input AdvEdt Entity Pot Optim View Process Help

DEE& 2 ="Wwm [SAAL & €S e 8

qm ] AEQRR D «=> ¢ 4 o

it ESC)

Wz
© 2 Wi
0000

O 7 Hoo
0 A B Foboon

& 5.2 MGrid ==y
Fle Edit poram iput AdvEdR Entiy ot o

DEES 2R =Ww
wm ]

Gambar 4. Pemasangasymetrical T-junction
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Step 6 Ulangi kembali step-step pada langkah 1 pembuaitadel elemen peradiasi,
dengan dimensi yang telah ditentukan pada Bab [karffangan Dimensi

Antena Mikrostrip Log-PeriodikCircular.

Step 7 Pilih Polygonyang baru dibuat. Sesuaikan posisinya dan telsdnift+Tab”
untuk memilih vertek yang akan disambungkan. Tel&mft+M” , pastikan
cursor berada padanodeset to closest vertedtan gerakkamolygon menuju
vertek referenskKlik dan pilihOk.

File EOU Poram iput ANV Entity Port optin View Process Help
DEEE 2R =Ww B/ RES % FR@aXTd %D

W E =) LEQQ 51 <> ¢ ¢ 5 W

SelectPohoon &
de

Sele
Mo

SelestExitEdtin +

Tl | 7
“ 2 s
1 Boooww

1 4 [0 Polygon

£ Messags | Geomely | Metalic Types | Substrates | Task List
lectpoygonmode ____ nm__ismom R ,_COPYPEN _ o Plane Wave efined

coss welp
§ Lo e e a8
AR D «=>§ ¢ 9

Select Palygon

o
1 B
4 Mo Poboen

Gambar 5 Penyusunan elemen peradiasi mengaichy log-periodik
Step 8 Ulangi tiap-tiap langkah da8itep 5-7an susumrray sesuai perencanaan.
Step 9 Setelah kelima elemen peradiasi dihubungkan sepeegncanaan, Pilih

Port>Port for Edge Group. Pilih vertek yang paling ujung dari saluran
transmisi. PilihPort->Exit Port.
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%2 lng periodik.geo - MGrid = il 2
File Edit Param Input advEdit Entity Port Optim \iew Process Help
D& T =W wm J IR B E B
T ma #2 =H LRI & R 2|« = ¥ ¢ 2 = = N 3
% 86,125 -
y: 798
z 16 x
dw: 86,125 Y
dy: 798 e
dz 16
dRho: 117.4113058 1
phi: 4291636292
dr: 117.4226071 .
theta: 6321926509 &
[T Z it
¥ z lheoomn g
1 B0 oooon o
& 30 Polygon
<
[
=
8]
a
=
@
@
il
=
v List All Layers
Elevated Layer -

Insert a Laper

Inform. ¥ &

Message Geometry | Metalic Types  Substrates  Task List

Drawing mode mm 1.40612% R2_COPYPEN Mo Plane Wawe Defined

Gambar 63. Hasil akhir perancangan

Step 10 Simulasikan hasil perencanaan seperti yang tekdbdtkan sebelumnya.

Step 11 Padamodua hasil keluaran simulasi dapat dipilih tampilan gmaeter baik
berupa grafik, data maupusmith chart (Controb>Define Display Data/
Define Display GraphDefine Display Smith ChattPilih Display Parameter
yang diinginkan).

Step 12 Selainmodua simulasi juga menghasilkan keluaran beruptiePn Viewdan
Current Viewjika kita mencentang opsurrent distribution filedanradiation
pattern file pada kotak dialogsimulation-SetupDari situ kita bisa melihat
animasi distribusi arus dan pola radiasi dari amtegik dalam 2D maupun 3D

(Display=>Pilih parameter yang ingin ditampilkan).
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Gambar 7. Antena Mikrostrip.og Periodic Circular

Gambar 15. Antena MikrostripLog Periodic Circularyang terhubung dengan
Agilent RF Network Analyz&714ES 300KHz — 3GHz
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»1:522 Refl Port2 !

D2: OF f
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Gambar 8 Hasil pengukuran VSWR pada rentang 2.3 GHz — HZ G

Gambar 9. Measurement site
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Gambar 18. Hewlett Packard RF Sweep Oscillator 8350B 0.01KP&-5GHz
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Gambar 19. Hewlett Packard Spectrum Analyzer 8563E 30Hz —@IA5
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